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Introduction 
 
Your new Scoop system comprises of two separate programs. Scoop Server runs on it’s own PC and 
is designed to sit in your rack or newsroom and capturing all audio and text feeds from your news 
sources. It automatically captures audio cuts to the ‘Audio Wall’ and records and sorts all incoming text 
stories, it even reads all the stories and highlights ‘key words’ that you can set for your station. 
 
Scoop can be used in the newsroom or out in the field to create and edit stories and prepare and deliver 
complete bulletins. You create stories from ‘Wire Feeds’ or from scratch, attach and edit audio cuts to 
stories and add additional notes and contact details. The News Break facility in Scoop will guide you 
through your prepared news bulletin, automatically displaying the scripts for your stories and cueing any 
audio cuts you need. 
 
The elements of Scoop combine to deliver all the tools and information you need for a modern digital 
paperless studio. 
 
Getting Started 
 
Once Scoop is installed and configured correctly on your PC (see the Scoop Installation Guide) you are 
ready to run Scoop for the first time. 
 
To load Scoop, simply double click on the Scoop Icon on your desktop or click on the Start button on 
your PC, select programs and finally select the Scoop Icon (see below) 
 

 
 
The Scoop Edit Icon 
 
 

 
Scoop will now load and you will get your first glimpse of the Scoop Edit. The left of the screen is 
dominated by the stories window. This is the hub of all information in Scoop, it contains all the raw 
and edited stories from your ‘wire feeds’ as well as any stories that you have written yourself. All 
Scoop Edit workstations share a common Stories Window so you will also have access to stories 
that other people have written. The Stories Window is also used to select stories to edit or review 
and to select stories for actual news breaks.  
 
Running along the bottom of the screen are the Scoop Cart Players. These are used for reviewing 
cuts, recording audio into the system and when in News Break mode, for automatically loading cuts 
that are associated to stories ready for playing out ‘on air’ 

 



The Rest of the Scoop Edit screen is used for editing stories, compiling News Bulletins and reviewing 
cuts on the ‘Audio Wall’ via the Cart Browser. 
 
 

The picture above shows the basic Scoop Edit screen with a story open. In the next section of the guide 
we will open and edit our first story, record an interview and save our finished piece. 
 

 



Opening And Editing Your First Story 
 
The basic essence of Scoop is to use stories that are either sent from a ‘wire feed’ or are created ‘in 
house’, to ultimately make bulletins that can be used on air. One of the most important features in Scoop 
is the ability to open and edit stories (regardless of their origin) for your needs. This section of the guide 
will help you to open your first story, edit the contents and assign an audio cut to the story. 

 
1. Select the category of story you want to edit a story from. N.B. All Stories displays all stories in 

the order that they were put on the system. 
 
2. Use the cursor keys (arrows) or the buttons to the right of the window to scroll down (or up) 

through the stories until the one you wish to edit is highlighted (in blue). 
 
3. Double Click on the story you want to edit or press the Ctrl & O keys to bring up the Story 

Edit Window.  

 



 
5. The white areas contain the editable text. The ‘Title’ is the story title. This is initially set by the 

‘wire feed’ provider or the original author but can be adjusted at any time, the Story window 
contains the editable story. The grey box underneath the Story window contains an original 
copy of the story (if available) that can not be edited. Clicking the left mouse button on the grey 
box will make it active, you can then drag and drop sections of text into the Story window (or 
into a new story altogether). 

 
6. You can add bold, italic, underlined, strike though text and coloured text to the edited story via 

the Edit Menu or the edit buttons as shown below. 
 
 
 

 
7. You can also change the Font and size of words or sentences by highlighting the section you 

want and selecting Fonts from the Edit Menu. 
 
8. Once you have finished with the story script you may want to add an audio cut called a Cart to 

the story. You may already have a Cart recorded onto the system, if this is the case then you 
can either type in the Cart Number into the Cart Number box on the story or look for the Cart 
you want to use using the Cart Browser. To do this click on the Browse button, this will open 
window that contains a numerical list of all the Carts available to you. You can jump to a 
specific Cart Number by clicking on the Jump Button (two right facing arrows) or pressing the 
‘J’ key on the keyboard and typing in the number. If you do not know what Cart Number you 
want but know what Cart Name you are looking for then you can click on the Find Cart button 
(a small pair of binoculars) or press the ‘F’ key. Next type in the Cart Description to search for 
the Cart you are looking for. 

  

 



 
 

 
 
 
 
 
 
The Cart Browser And The 
Jump To Cart Window 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Find Cart results are displayed listed in numerical order, to select the one you want simply double 
click on it. 
9. Once you have found the Cart you want to attach to your story, you can either double click on 

it, right click on it and choose the Select option or Click on the Select button (the Tick). 
 
10. Let us assume that you do not have a Cart pre-recorded on to the system but you want to 

record a new Cart onto the system. To do this you can either specify any empty Cart Number 

 

 



to record into (by either typing in a number or using the Cart Browser see section 7) and 
clicking on the record button (red circle). If you do not know what number to record into (or do 
not care) then clicking on the Record button when the Cart Number is empty will make Scoop 
find the first empty Cart in your Scoop Workstations designated work range and start recording 
into it. 

 

11. Which ever method you have used to start recording, to stop recording, all you have to do is 
click on the Eject button (upward facing underlined arrow) on the Cart Player at the bottom of 
the screen. 

 
12. Once you have finished recording, your Cart, you may wish to edit it. To do this click on the 

Edit Cart button (the green wave form icon). This will take you to your chosen Audio Editor 
(usually Cool Edit 96, 2000 or Pro). 

 
13. Once Cool Edit (which ever version you use) has loaded, you will be presented with a graph of 

that represents the sound of the Cart, this is called a waveform and it gives a method to visualise 
and edit sound files with digital accuracy. 

 
We will not dwell on Editing for too long, just the basics but for more information on the 
power of Cool Edit, please consult the Cool Edit Help Files. 

 
The most basic (and probably most used) function of the digital audio editor is to delete 

 



unwanted parts of the Cart. To do this in Cool Edit, use the left mouse button to highlight the 
section of the wave form that you want to remove and hit the ‘del’ key on your keyboard. If 
you make a mistake, the Undo button (a curved arrow) or the Undo Last option on the Edit 
menu can be very useful. 
If you need a closer look, highlighting a section and clicking on the Zoom To Selection button (a 
magnifying glass on a box) will zoom in to display only the bit of the wave form that you have 
highlighted. This makes delicate editing simpler and more accurate. To return to the full wave 
form, click on the Zoom Out Full button (magnifying glass over a sheet of paper). 

 
Tip: If you are not sure what a button does, hover the mo use pointer over the button for 
a couple of seconds and a short button description will appear.  

 
Once you have finished editing the wave form, click on the cross in the top right corner of Cool 
Edit to close the program, you will be asked if you wish to save the changes, if you are happy 
then click on Yes, if not click on No and none of your changes will be saved. Once the file is 
saved, you will be returned to Scoop. 

 
14. We have now finished editing both the Story and the Cart so all we have to do is save the 

overall Story. To do this click on the cross in the top right hand corner of the Story Edit 
Window, you will be asked if you want to save the Story, answer Yes if you are happy or No if 
you do not want to keep your changes. Alternatively you can click on the Save Story button 
(the button with a floppy disk on it) or press the Ctrl + S keys on the keyboard. Either of these 

 



will save the story but neither will close the story after saving it. 
 
 
Creating A News Story From Scratch 
 
To create a new news story from scratch in Scoop, follow these simple steps. 
 
1. Starting A New Story: Click on the New Story icon. 

 
 
 

 
 
 

 
Alternatives: You could also click on the File Menu option and select New Story or simply press 
the Ctrl + N keys together.  
 
2. Selecting A Category: Select the Category of story you want to create by highlighting it in the drop 
down list and clicking on OK (or double clicking on it). 
 

 
 
 
 
 
 

 
 
3. Story Title & Text: Give the story a title and press the Tab key to move to the main story text 
window. You can now type your story using bold text, italic text, underlines, different font sizes and 
colours to enhance the story and make it easier to read on air. 

 

 



 
 

 



4. Adding Notes: If you wish you can also add notes to a story by clicking on the Notes Tab at the top 
of the Window and typing the notes into the white box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
5. Story History: Each story keeps a history of when it was last edited. This history can be viewed by 
clicking on the History Tab at the top of the screen. 
 
6. Cut Number: Once you have finished with Story Text, Notes and History, you can add a cut number 
to the story. You type the cut number into the Cut Number Box. 

 
 
 
 
 

 
7. Attaching A Cart From The Audio Wall: We will now assign an Audio Cut called a Cart to the story. 
We will assume that the Cart has already been recorded and edited and that it is on the Scoop Audio 
Wall. We will cover, recording a new Cart in the next step. If you know the Cart Number of the Cart 
you want then you can simply type in the Cart Number into the Cart Number Box. If not then clicking 
on the Browse button will open the Cart Browser. This is a list of all the Carts on the system and can be 
used to select the Cart we want. 
 
The Cart Browser will automatically go to your Scoop Workstations edit range when first 
opened although you can use a Cart from anywhere in the News area. You can 
jump to a specific Cart Number by clicking on the jump button   (or pressing the J 
key) and typing in the number. 

 

 

 

 



 
You can search for a Cart Title by 
pressing the Find Cart button    (or 
pressing the F key) and typing in the 
Cart Title you are looking for. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
If you want to review a Cart to check it is the one you want, highlight the Cart and click on 
the Play Cart button  or right click on the Cart and select Play. 
 
 
Once you have the Cart you want, you can either click on the Select button      , 
right click and choose Select or simply double click on the Cart to select it. 
 
8. Recording A Cart: If the Cart you want for your story is not already recorded onto the system then 
you may need to record it. To do this, you have two choices.  
 
Method A: You can specify the Cart Number you want to record into, this can be done by typing in 
the Cart Number you want to record into and clicking on the Record button. 
 
 
Alternatively you can click on the Browse button, right click on an empty cart and choose Record from 
the menu (see step 7 for more info on the Cart Browser). 
 
Method B: The alternate method is to let Scoop find the next empty Cart in your Scoop Workstation’s 
edit range. To do this, make sure that no Cart Number is entered in the Cart Number slot, next click on 
the Record button.  
 
 
Scoop will automatically find the next empty Cart and start recording into it. It will also set the Cart 

 

 

 

 

 



Number for the story to the Cart you are recording. 
 
9. Stopping Recording: To stop recording (whichever method you used to start recording), simply click 
on the Eject button .   Select Yes when asked if you want to save the cut. 
 
 
10. If you are happy with story, click on the   in the top right corner of the story to close it and 
Click on Yes to save the story. 
 
Quick Guide To Creating Bulletins 
 
Once you have all your stories edited and Carts attached then you are ready to create a Bulletin. The 
Bulletin is the running order of the stories you want for a particular news break and is built up using the 

Bulletin Builder. The simple steps below show you how to go about creating a News Bulletin. 
 
1. Click on the Display Bulletin Builder button to open the Bulletin Builder. 
 
 
              The Display Bulletin Builder Icon 
 
2. Use the left mouse button to drag stories from the Stories Window on the left into the Bulletin 

Builder.              
 

 

 

 

 



 
3. You can juggle the order of the stories in the bulletin by simply Dragging them around in the Bulletin 
Builder. 
 
 



4. If you wish to preview the contents of the stories then you can click on the Preview Story Button  
 

   The Preview 
Story 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Double clicking on a story will open the Story Edit window and allow you to edit any stories in the 
Bulletin Builder. You can also open them for editing by highlighting the story and clicking on the Edit 
Story button. 

 
     Edit Story Button 

 
 
6. Any stories can be removed from the Bulletin Builder by either right clicking and selecting the 
Remove option or by clicking on the Remove Story button (the cross) 

 
     The Remove Story Button 

 
 
7. Give the Bulletin a title so that you can find it again. 
 
8. Click on the Save button to save the Bulletin, you will be asked the time and date of the Bulletin 
before the Bulletin is saved. 

 
   The Bulletin Save Button 

 
9. If you want to print a hard copy of the Bulletin then click on the Print Button (the one with the printer 
on it), a complete print out of the stories in the Bulletin will be sent to the printer. 
 
10. Click on the cross in the top right hand side of the Bulletin Builder. If you have not saved the Bulletin 
before doing this you will be prompted to save first. You are now ready for the read your break live on 
air. 
 

 

 

 

 

 



Quick Guide To Scoop Playout Screen 
 
So, you have written your stories, you have edited your Carts and built your bulletin. You’ve eaten your 
sandwiches, had a cup of tea and checked your e-mail twice but there is no way round it, it’s time for 
your first news break with Scoop. So off you wander to the news booth lucky rabbits foot in hand but 
don’t worry, you have already done all the hard work, the rest is a breeze so just sit back and relax. It’s 
time for the news. 
 
1. The Scoop Workstation in the News Booth is set up to display the Scoop playout window by 
default. All the workstations can do it so you can have a practice. 
 
2. Click on the Open Bulletin (the paper clip) button to select open a bulletin. 
 
3. Select your Bulletin from the list, it will automatically select the Bulletin closest to the current time but 
you may have to scroll up or down to find your Bulletin. 

 
 
 
 

      The Bulletin Selector Box 
 
 
 
 

 
 
4. The first story will be displayed in the Current Story window. If a Cart is associated with the story, it 
will be cued automatically ready for playout. 

 

 



5. Read your story and trigger your Cart at an appropriate time. This is done with either the Play Cut 
button on your button box, hitting the ‘Space Bar’ on the keyboard or clicking on the Speaker Icon 
button. 

 
              Play Cart Button 
 
 

 
6. While the Cart is playing, use the Next Story button on your button box (the big down arrow) or the 
‘+’ key on the numerical keyboard to move on to the next story, this will also cue the next Cart for your 
ready for playing. Alternatively, click on the Up & Down buttons 

 
               On Screen Next & Previous Story Buttons 
 

 
7. The final story will appear in a different colour so you know that it is coming. That’s it, easy really 
although there are a couple of extra options you should know about. 
 
Options 
 
8. Previous & Next Story Buttons: You have a couple of options open to you, firstly you can have only 
the current story on screen, the current and the previous, the current and the next or all three. This is a 

very personal setting so experiment to get the best view for you. 
 
              Clicking on these two buttons toggles previous & next story view 
 

 

 

 

 



 
 
 

 
 
 
 
            Previous & Next Stories Displayed 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
Previous Story Only 

 

 



9. The Instant Carts: Instant Carts are used in Scoop as short cuts to beds, stabs and other important 
Audio Carts. They are setup in Scoop edit and are triggered by the number keys. Again, this is probably 
something to have a go with before your first bulletin or when you get a spare minute. The button has a 
picture of a finger pushing a button on it. 

 
 

   The Display Instant Carts Button 
 

 
 
 

The Instant Carts Offer Short Cuts To Commonly Used Carts 
 
 
10. News Flash: If in the middle of your break, a yellow exclamation mark icon starts flashing at you, 
that means that someone has sent you a news flash. Click on the button to view the flash, it may be 
important. Click on OK to close the News Flash Window. 

 

 

  



 


